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Resumo: Este artigo apresenta uma proposta de delimitação da faixa de fronteira do Brasil, no Estado
do Mato Grosso do Sul. Esta proposta baseia-se na metodologia apresentada na dissertação, intitulada
"Metodologia   para  Caracterização  Espacial  da  Faixa  de  Fronteira  do  Brasil",  submetida  ao
PGEC/UERJ, para obtenção do título de Mestre. Os resultados indicam a viabilidade desta metodologia
ser aplicada aos outros estados fronteiriços do  País.

Palavras chaves: Limites territoriais, Geomática,  Geopolítica, Cartografia, SIG.
 
Abstract: This article presents a proposal of delimitation of the border strip of Brazil, in Mato Grosso do
Sul  State. It  is  based  on   the methodology  presented  in  the  dissertation,  entitled  "Methodology for
Spatial  Characterization of the Border Strip of Brazil", submitted to the PGEC/UERJ, for  the obtainment
of the Master Degree. The results point out the viability of the  application of this methodology to the
other frontier states of the  Country.
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1 Introdução

A proposta metodológica de Silva (2003) embasada neste estudo de caso para delimitação da Faixa de
Fronteira do Brasil foi produzida a partir de um estudo técnico-científico realizado junto ao Programa de
Pós-Graduação em Engenharia de Computação (PGEC), da Universidade do Estado do Rio de Janeiro
(UERJ) – Mestrado na Área de Geomática, com o objetivo de solucionar os problemas causados pela
inexistência  de  uma  definição  clara  dos  limites  desta  faixa,  a  qual  vem  afetando  o  processo  de
identificação  de municípios  com  área localizada parcial  ou totalmente  dentro  desta  parte  do  território
brasileiro, ora realizado pela Fundação Instituto Brasileiro de Geografia e Estatística (IBGE).

Para aplicação desta metodologia, foi escolhido o Estado do Mato Grosso do Sul que atendeu a dois
requisitos fundamentais estabelecidos para escolha: o primeiro, foi de que se deveria escolher um Estado
fronteiriço que possuísse pelo menos uma reentrância significativa em seu território,  permitindo assim
observar a aplicação da referida metodologia, no tocante à geração de círculo de raio igual à largura da
faixa de fronteira e com vértice na interseção dos segmentos da Linha de Base Reta da Fronteira (LBRF),
segundo o desenvolvimento de “buffer”  elementar,  o qual  foi  a ferramenta de Sistema de Informação
Geográfica (SIG) usada para se projetar a Linha Interna da Faixa de Fronteira (LIFF) e os Limites da Faixa
de Fronteira (LFF); e, o segundo, foi de que o Estado fronteiriço possuísse fronteira com mais de um País
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vizinho, contíguo ao território nacional.

Um outro aspecto que também colaborou na escolha do Estado do Mato Grosso do Sul para estudo de
caso foi de que a última grande alteração ocorrida no quadro municipal da Divisão Territorial do Brasil
(DTB), instalações de municípios realizadas em janeiro/2001, não incluiu novos municípios dentro da faixa
de fronteira no estado, de acordo com informações obtidas do cadastro de municípios do IBGE, facilitando
assim a utilização de informações textuais e gráficas mais atualizadas dentro da região em questão, sem
que houvesse conflitos entre elas.

Assim, este estudo de caso serviu para proporcionar sustentabilidade a metodologia em questão e avaliar
a viabilidade de sua aplicação nos outros Estados brasileiros fronteiriços.

2 Materiais e Métodos

2.1 Softwares

Neste estudo de caso,  o software ArcMap da família ArcGis da ESRI poderia ter  sido empregado na
maioria dos processos, mas outros programas de computador também foram considerados, escolhidos por
simples conveniência (Tabela 1).

Tabela 1: Programas de computador utilizados nos principais processamentos. Fonte: Silva (2003, p. 81).

ENTRADA PROCESSOS SAÍDA
Internet Explorer/word

- Dados primários de Marcos de
Fronteira (html).

Aquisição de dados
Adequação de dados

- Dados de Marcos de Fronteira
(txt).

Access
- Dados de Marcos de Fronteira
(txt).

Adequação de dados - Dados selecionados e
transformados de Marcos de
Fronteira (dbf).

ArcView
- Dados selecionados e
transformados de Marcos de
Fronteira (dbf).
- Limites estaduais e municipais
(dgn e shp).
- Buffer de LBRF
- Recorte de imagens orbitais

Traçado da LBRF

Constituição da Faixa de
Fronteira

- LBRF (shp)

- LFF (shp)

- Mapas (shp)

Microstation
- Limites municipais da MMD (dgn) Traçado da LBRF - limites municipais da MMD

segmentados (dgn)
ArcMap

- LBRF Projeção da LIFF - Buffer de LBRF

2.2 Dados de Entrada

Os dados utilizados neste estudo de caso foram: vetoriais – os marcos de fronteira e os limites territoriais
dos municípios, e matriciais – imagens de sensores orbitais; conforme descritos a seguir:

a) Os dados dos marcos de fronteira dos limites internacionais do Brasil  com os Países contíguos ao
território do Estado do Mato Grosso do Sul foram obtidos, via internet, do sítio da Segunda Comissão
Brasileira Demarcadora de Limites (SCDL, 2002), em duas relações armazenadas no formato “html”. Uma
relação contendo os dados dos marcos de fronteira Brasil-Paraguai (situação em Novembro/98) e a outra
contendo os dados dos marcos de fronteira da parte sul de Brasil-Bolívia (situação em Abril/98). Elas foram
copiadas do navegador de internet para dentro de um documento do processador de texto Word.

Alguns marcos de fronteira não foram considerados no limite internacional do Brasil no Estado do Mato
Grosso do Sul, conforme mostrado na Tabela 2.
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Tabela 2: Quantidade de Marcos de Fronteira no limite internacional do Brasil no Estado do Mato Grosso do Sul.
Fonte: Silva (2003, p. 82).

RELAÇÃO DE
MARCOS DE
FRONTEIRA

QUANTIDADE
DE MARCOS

RELACIONADOS

QUANTIDADE
DE MARCOS

USADOS
OBSERVAÇÃO

BR-PA 916 910
-1 (+Foz do Apa = duplicado)
-2 (+Pt.Tripart.BRPABO e M. Ref.
Tripart.(PA)= BR-BO)
-3 (caso de marcos lado a lado)

BR-BO
(Parte Sul)

402 122 -278 (fora dos limites no MS)
-2 (caso de marcos lado a lado)

TOTAIS 1318 1032 - 286 marcos excluídos.

b) Os dados dos limites territoriais relativos às linhas de divisa dos estados e municípios fronteiriços foram
obtidos junto ao antigo Departamento de Cartografia do IBGE. Esses dados gráficos e não gráficos dos
limites dos estados brasileiros e dos limites dos municípios do Estado do Mato Grosso do Sul são oriundos
do arquivo fonte, sem supressão de pontos, consolidados na escala de 1:250.000 para produzir a Malha
Municipal Digital do IBGE. Os arquivos foram adquiridos no formato “shp” contendo o contorno dos estados
brasileiros, em nível de Brasil, e no formato “dgn” contendo os limites municipais em nível de estado.

c) Os dados dos recortes das imagens orbitais foram obtidos do CD Mato Grosso do Sul da Coleção Brasil
Visto do Espaço adquirido da EMBRAPA Monitoramento de Satélites. Tais dados estão disponibilizados
em arquivos “html” e “jpeg” dentro de diretórios organizados por formato de arquivo e nível de escala. A
Figura 1 mostra a organização dos dados dentro do CD. 

Com o objetivo de propiciar uma melhor visualização dos trechos dos limites territoriais na fronteira foram
selecionados os recortes de imagens orbitais com maior nível de detalhamento que recobrem a fronteira
internacional, ou seja: os recortes com resolução espacial de 30m, na escala de 1:25.000, os quais estão
armazenados nos arquivos da pasta IMG0, correspondendo a 119 arquivos com os recortes das imagens.
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do Espaço 
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Neste caso, “IMG” significa pasta de arquivos de imagens armazenadas no formato “jpeg” e o número
seguinte “0” significa o nível de escala dos recortes de imagem desta pasta. Também, foram selecionados
os recortes de imagens orbitais com menor nível de detalhamento, escala 1:250.000, para visualizar a área
da faixa, bem como visualizar todo o estado. A Tabela 3 mostra a quantidade destes recortes de imagens
por escala dentro do estado. 

Tabela 3: Quantidade de Recortes de Imagens Orbitais no Estado do Mato Grosso do Sul, no formato “jpeg”, por
escala. Fonte: Silva (2003, p. 84).

NÍVEL DE ESCALA
QUANTIDADE

DE RECORTES
(ARQUIVOS)

QUANTIDADE
DE RECORTES

UTILIZADOS
ESCALA

0 2099 119 1:25.000
1 555 0 1:50.000
2 156 0 1:100.000
3 34 34 1:250.000

Também foram baixadas da internet informações sobre resolução e superposição das imagens orbitais
recortadas para composição do mosaico do estado, segundo articulação das folhas topográficas (Tabela
4).

Tabela 4: Dimensão e Resolução dos Recortes de Imagens de Satélites. 
Fonte: EMBRAPA Monitoramento de Satélites.

Estado
Largura

da
Imagem

Largura
Total

Comprimento
da

Imagem
Comprimento

Total

Tamanho
do

Pixel(m)

Tamanho
do Pixel
(graus

decimais)
Nível

Mato Grosso do Sul
MS 454 500 303 400 360 0,00331116 3
MS 454 500 454 500 120 0,00110372 2
MS 454 500 454 500 60 0,00055186 1
MS 454 500 454 500 30 0,00027593 0

2.3 Métodos

Em resumo, a nova metodologia aplicada neste estudo de caso, consiste no desenvolvimento de uma linha
no meio digital ao longo do limite internacional do Brasil, constituída com o maior número de segmentos de
reta extraídos de determinados trechos dos limites dos municípios brasileiros fronteiriços, digitalizados de
cartas  topográficas  (IBGE,  1997),  os  quais  são  intercalados entre  os  marcos  de fronteira  para  servir
especificamente de base para projeção do limite interno da faixa de fronteira (linha paralela a 150km do
limite do país). Com operações de buffer a partir desta linha de base deverá ser gerada uma nova feição
geográfica que será utilizada em operações de interseção e união de dados espaciais, a fim de produzir os
limites da Faixa de Fronteira do Brasil.

Esta nova metodologia, desenvolvida para caracterizar espacialmente a Faixa de Fronteira do Brasil, se
apropria  de  vários  métodos  e  técnicas,  tais  como:  transformação  entre  Sistemas  Geodésicos  de
Coordenadas, representação cartográfica Eqüidistante Azimutal,  Operação de Buffer  desenvolvido para
Analise de Proximidade entre dados espaciais e de outras operações de geoprocessamento presentes nos
Sistemas de Informações Geográfica, entre outros, conforme abordados em Silva (2003, cap. 3).

Um dos métodos desenvolvidos pelo Enviromental Systems Research Institute (ESRI) para operação com
a  ferramenta  “Buffer  Wizard”  do  SIG  ArcMap  da  família  ArcGIS,  denominado  “Feature  Optimized
Coordinate System”,  utiliza-se de um algoritmo que cria um sistema temporário  de coordenadas para
operações de “buffer”, baseado em uma projeção Eqüidistante Azimutal. Uma vez criado, os buffers são
reprojetados e gravados no sistema de coordenadas da estrutura de dados para cada feição que está
sendo processada (ESRI, 2001a; ESRI, 2001b). Isto  implicou na escolha deste programa para projeção
dos limites da faixa de fronteira em direção ao interior do País.

Bakker (1965, p.32), quando faz um resumo das propriedades da representação cartográfica Eqüidistante
Azimutal,  afirma:  [...]  “quando se necessita  de uma carta  com a finalidade específica  de  representar
verdadeiras distâncias a um determinado ponto, essa projeção pode ser usada com excelentes resultados,
fazendo-se o tal ponto centro da projeção (ponto de tangência)”.
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3 Procedimentos Passo à Passo

PASSO 1: De posse dos dados relativos aos marcos de fronteira Brasil-Paraguai e Brasil-Bolívia (parte
sul), baixados da Internet, abriu-se cada arquivo com o processador de texto Word para eliminação das
linhas indesejáveis sobre título, cabeçalho e nota no final de arquivo. A seguir, configurou-se os dados do
documento alterando-se os tipo e tamanho da fonte visando padronizar os dados no ambiente de trabalho
e, principalmente, proporcionar um visual da tabulação dos dados e das quebras de linhas facilitando a
exclusão das  mesmas.  Daí excluiu-se as linhas indesejáveis  e,  depois,  os dados foram salvos  como
“somente texto com quebra de linha”, em um arquivo no formato “txt”. Uma visão da execução deste passo
com os dados dos marcos de fronteira dos limites entre Brasil e Paraguai é fornecida a seguir (Figura 2).

PASSO 2: Os dados do arquivo “txt” foram importados para um objeto do tipo tabela do software Access,
na qual foi criada uma estrutura adequada de tabela para receber todos os dados do arquivo “txt”, como
mostrado nas Figuras 3 e 4.
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Figura 2: Exemplo de preparação dos dados dos marcos de fronteira Brasil-Paraguai

Figura 3: Dados dos marcos de fronteira Brasil-Paraguai importados para uma Tabela do software
Access
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PASSO 3:  Excluiu-se os campos da Tabela com os dados que não seriam utilizados, permanecendo
somente as informações de identificação do nome e suas coordenadas geográficas, conforme mostra a
Figura 4. 

PASSO 4: Criou-se um objeto do tipo consulta com critério para excluir os registros com a presença do
caractere de menor (“<”) no campo que identifica o nome do marco de fronteira (campo1) a fim de eliminar
os registros indesejáveis, e para transformar as coordenadas geográficas de grau, minuto e segundo para
grau decimal, a partir da criação de dois campos calculados. A Figura 5 mostra a estrutura deste objeto
consulta e logo a seguir é fornecido um exemplo deste campo calculado que foi usado para transformação
do valor da coordenada de latitude.

Um exemplo de campo calculado pode ser visto a seguir na expressão criada para transformação dos
valores da coordenada de latitude de grau sexagesimal para grau decimal utilizando-se do objeto Consulta
dentro do ambiente do Access. O resultado está na ilustração a seguir (Figura 6).

LatGrau: ([Campo4]/60+[Campo3])/60+[Campo2]

Onde:
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Figura 4: Estrutura da Tabela Access com exclusão de campos

Figura 5: Consulta em Access para eliminação de registros e transformação de unidades de grau
sexagesimal para grau decimal
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LatGrau = nome do novo campo gerado na Consulta;
Campo4 = campo da Tabela com os segundos de latitude;
Campo3 = campo da Tabela com os minutos de latitude;
Campo2 = campo da Tabela com os graus de latitude.

PASSO 5: Exportou-se os dados resultantes da aplicação do objeto consulta feita na tabela de dados para
o formato “dbf” que é nativo do “software” dBase e usado pelos programas da família ArcGis da ESRI.

PASSO 6:  De posse dos dados relativos aos recortes das imagens orbitais  do estado realizou-se no
ambiente do software ArcView a identificação das cenas na escala 1:25.000 (o procedimento é semelhante
para os outros níveis de escala). Identificou-se o nome do arquivo em “html” no campo de endereço de
arquivos na página do navegador, após clicar várias vezes na imagem do mosaico, no extremo norte do
estado, na fronteira internacional do Brasil, até o nível correspondente à escala de 1:25.000, a fim de
selecionar a imagem de interesse na pasta IMG0, com o mesmo nome do arquivo da imagem identificada,
porém, no formato “jpeg”. O primeiro arquivo de imagem selecionado foi o denominado “MS12_17.JPG”,
conforme seqüência apresentada na Figura 7. 

PASSO 7:  Montou-se  um  esquema  de  quadrículas  sobre  a  região  de  fronteira  para  lançamento  de
longitudes e latitudes de algumas posições estratégicas do reticulado, auxiliando assim a identificação dos
arquivos de interesse para georreferenciamento das imagens orgitais, tendo em vista que a denominação
do arquivo é composta pela SIGLA DO ESTADO + Nº DA LINHA + Nº COLUNA + EXTENSÃO. Os
números de linha e de coluna se referem à grade de articulação das folhas topográficas dentro da escala
escolhida, assim, o arquivo selecionado corresponde a um recorte de imagem que abrange uma área de 7’
30” por 7’ 30”, sem considerar a faixa de superposição existente entre os recortes. Um exemplo deste
esquema pode ser observado na ilustração a seguir (Figura 8).
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Figura 6: Resultado da Consulta Seleção do Access após o processo de Adequação de Dados

Figura 7: Seleção dos recortes das imagens orbitais conforme escala
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E, também, visando agilizar o georreferenciamento dos recortes das imagens orbitais, construiu-se uma
tabela de conversão dos minutos e segundos do grau sexagesimal para grau decimal das coordenadas
geográficas possíveis de uso na articulação dos recortes da escala de 1:25.000 para grau decimal (Tabela
5).

Tabela 5: Conversão dos minutos e segundos de grau sexagesimal para grau decimal para auxiliar a criação dos
arquivos de georreferenciamento. Fonte: Silva (2003, p.90)

GRAU SEXAGESIMAL GRAU DECIMAL
0º 07’ 30” 0,125º
0  15 0,25

0  22  30 0,375

0  30 0,5
0  37  30 0,625
0  45 0,75
0  52  30 0,875

  
      
PASSO  8:  Obteve-se  as
coordenadas  geográficas  do
canto superior esquerdo (CSE)
do  reticulado  apresentado  na
página  do  navegador,  onde
está posicionado o recorte  da
imagem orbital correspondente
à área da folha topográfica na
escala  selecionada,  logo
abaixo da grade de articulação.
Por  exemplo,  no  caso  do
primeiro  recorte  de  imagem
identificado, arquivo MS12_17,
estas  coordenadas  são:
Latitude =  -17º 30’ e Longitude
= -57º 52’ 30”.  A ilustração, a
seguir,   destaca  o  referido
reticulado  da  página  do
navegador (Figura 9).
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Figura 8: Exemplo de esquema de quadrículas sobre a linha de limite
internacional do Brasil para auxiliar no georreferenciamento dos recortes
das imagens orbitais na escala 1:25.000

Figura 9: Informações sobre as coordenadas geográficas do recorte da imagem orbital
selecionada
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PASSO 9:  Calculou-se o tamanho do pixel  em grau decimal,  com a aplicação de uma regra de três
simples, conforme fórmulas a seguir, a partir das informações sobre os recortes das imagens orbitais do
estado (Tabela 4).

Tpx  =  Lx     e        Tpy  =  Cy
            Li                           Ci

Onde:
Tpx = Tamanho do pixel em x;
Lx   = Largura da área do recorte em grau decimal;
Li    = Largura da imagem em pixel;
Tpy = Tamanho do pixel em y;
Cy   = Comprimento da área do recorte em grau decimal;
Ci    = Comprimento da imagem em pixel

Neste exemplo, obtêm-se na Tabela 4 as dimensões da imagem (em pixel): Largura = 454 e Comprimento
= 454.
Como o tamanho do pixel é igual tanto da direção das longitudes quanto na direção das latitudes, temos:

454 pixel à 7’ 30” (=0,125º)
1     pixel à X

Ou seja: Tpx = Tpy = X = 0,125º/454 = 0,00027533º

Obs.: A Tabela atualmente disponível pela EMBRAPA, com as informações sobre os recortes de imagens
orbitais, já dispõe de uma coluna informando o tamanho do pixel, em grau decimal, para todos os estados
e níveis de escala.

PASSO 10: Calculou-se a área de superposição do recorte (borda), a partir das informações sobre os
recortes das imagens de satélites do estado. Da Tabela 3, obtêm-se, além das dimensões da imagem
(454x454), a largura e o comprimento totais, sendo ambos iguais a 500 pixels no estado em questão. O
cálculo para se conhecer o tamanho desta borda (área existente além da área útil do recorte segundo a
articulação das folhas topográficas)  pode ser  feito com o formulário abaixo,  de acordo com o critério
adotado na elaboração dos recortes (observação a seguir).

- Tamanho da borda nas laterais oeste (LO) e leste (LL)

LO = (Largura Total – Largura da Imagem)/2
LL = Largura Total - (Largura da Imagem + LO)

- Tamanho da borda nas laterais norte (LN) e sul (LS)

LN = (Largura Total – Largura da Imagem)/2
LS = Largura Total - (Largura da Imagem + LN)

No georreferenciamento deste recorte na escala de 1:25.000, aplicando-se as fórmulas acima, têm-se uma
borda de 23 pixels em todas as laterais, devido às larguras e comprimentos dos recortes serem iguais, não
existindo diferença impar entre as dimensões.
 
Assim, se 1 pixel vale 0,00027533 tem-se uma borda  = 0,006332599º, portanto: 

LO =  LL = LN = LS = 23 pixels = 0,006332599º

Obs.: Critério adotado pela EMBRABA na elaboração dos recortes de imagens - Quando a diferença entre
as extensões da área total e da área útil da imagem de uma determinada direção do recorte (largura ou
comprimento da imagem) for ímpar o critério estabelecido pela Embrapa Monitoramento de Satélites é de
que  as  laterais  leste  ou  sul  do  recorte  será  1  pixel  maior  que  a  outra  lateral,  conforme  a  direção
considerada

PASSO  11:  Determinou-se  as  coordenadas  do  ponto  de  georreferenciamento  (PG),  ampliando  a
quadrícula  relativa  à  área  da folha topográfica  em questão,  no ponto  de coordenadas lidas do canto
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superior esquerdo (CSE), com o valor da borda calculada para as laterais oeste e norte do recorte da
imagem, utilizando-se das fórmulas a seguir:

Latitude de PG = Latitude de CSE + LN
Longitude de PG = Longitude de CSE - LO

As coordenadas lidas no CSE da quadrícula da folha SE-21-V-D-V-1-NE são: Latitude = -17º 30’ (-17,5º) e
Longitude = -57º 52’ 30” (-57,875º). Assim, para o recorte de imagem do arquivo MS12_17 as coordenadas
do ponto de georreferenciamento foram:

Latitude de PG = -17,5 º + 0,006332599º = -17,4936674º
Longitude de PG = -57,875º - 0,006332599º = -57,8813326º

PASSO 12: Criou-se o arquivo ASCII com os parâmetros de georreferenciamento (“World File”), de acordo
com as convenções estabelecidas para este tipo de arquivo, ou seja: mesma denominação do arquivo que
contém os dados da imagem acrescido da letra “w” na sua extensão. O arquivo criado para o recorte da
imagem  armazenada  em  MS12_17.jpg  ficou  com  a  seguinte  denominação:  MS12_17.jpgw  e  com  o
conteúdo ilustrado a seguir (Tabela 6).

Tabela 6: Exemplo dos parâmetros de georreferenciamento do recorte da imagem orbital - arquivo MS12_17.jpgw no
formato ASCII. Fonte: Adaptado de ESRI (1999b).

PARÂMETROS DESCRIÇÃO
0.00027533 = valor positivo do tamanho do pixel na direção de X
0
0
-0.00027533 = valor negativo do tamanho do pixel na direção de Y
-57.8813326 = longitude do ponto (canto superior esquerdo do reticulado)
-17.4936674 = latitude do ponto (canto superior esquerdo do reticulado)

PASSO 13: Seguiu-se por intermédio dos comandos do navegador de consultas dos recortes (Figura 10)
para identificação dos demais arquivos até a seleção de todos recortes das imagens de satélites que
recobrem os limites internacionais; reiniciando esta seqüência de passos, sempre navegando no sentido
norte-sul junto ao extremo oeste do estado.

PASSO 14: Para o traçado da Linha de Base Reta da Fronteira, segmentou-se no ambiente do programa
“Microstation” os limites municipais no formato DGN oriundo da MMD do IBGE. Primeiro selecionou-se
todos os elementos em torno de uma “fence” e depois, aplicou-se a ferramenta “drop element”, a fim de
separar os elementos “lines” da “polyline” para possibilitar a edição dos trechos dos limites municipais. Isto,
após ter dado carga do arquivo (f50.dgn) contendo os limites municipais do estado,  conforme ilustrado a
seguir (Figura 11). Depois, salvou-se o arquivo contendo os elementos geométricos (segmentos do tipo
“lines”)  como  “MunMS250.dgn”.  Nesta  operação  ocorreram  na  “polyLine”  a  quebra  de  78  elementos
geométricos do tipo “Complex shape” e “Shape” para 92357 elementos geométricos do tipo “line”.
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Figura 10: Vista dos comandos do Navegador de Consulta aos recortes de imagens
orbitais adjacentes
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PASSO 15: Configurou-se o ambiente do software ArcView, procedendo habilitação da extensão: “File =>
Extensions => CAD Reader”, para se trabalhar com dados de CAD, e alterações de outras informações
(nome da “View” e unidades no mapa, de coordenadas para grau decimal e de distância para metros ) para
adequação da interface de dados gráficos: “View => Properties”. Neste momento, convém salvar logo o
projeto com um nome e local apropriados.

Obs.:  Na  oportunidade,  configurou-se  também  as  extensões:  “Database  Access”,  “geoprocessing”,
“graticules and Measured Grids” e “JPEG (JFIF) Image Support”.

PASSO 16:  Criou-se dois temas:  um com os
dados da MMD do Estado do Mato Grosso do
Sul e outro com os do Brasil. Daí, selecionou-
se  os  dados  de  limites  dos  municípios
fronteiriços  do  estado  junto  à  fronteira
internacional, entre os limites estaduais norte e
sul,  com a ferramenta “Select  feature”. Deste
modo, foram identificados 3465 segmentos que
compõem  a linha dos  limites  fronteiriços  dos
municípios  (LLF)  que  foram convertidos  para
dentro  de  um  arquivo  SHP e,  logo  a  seguir,
inseridos  no  ambiente  de  trabalho,  conforme
ilustrado na figura a seguir (Figura 12).
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Figura 11: Segmentação dos limites da MMD do IBGE em linhas menos complexas
no ambiente do Microstation

Figura 12: Tela do ArcView mostrando o ambiente de construção da
linha de limite fronteiriço
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PASSO 17: Inseriu-se no ambiente de trabalho os arquivos com os dados dos marcos de fronteira entre
Brasil-Bolívia (parte sul) e Brasil-Paraguai, como tabelas do ArcView: “Project => Add Table”.

PASSO 18:  Criou-se  dois  temas  no  ambiente  de  trabalho  a  partir  das  coordenadas  dos  marcos  de
fronteiras: “View => Add Event Theme” (o campo “X field”  corresponde a Longitude e o campo “Y field” a
Latitude) e ajustou-se os símbolos adotados no momento da adição dos temas. 

PASSO 19:  Inseriu-se como tema no ambiente de trabalho do Arcview as imagens orbitais que foram
processadas,  as  que  recobrem  a  região  de  fronteira  (1:25.000)  e  o  estado  (1:250.000)  que  foram
georreferenciadas a partir de dados sobre os recortes.

A ilustração (Figura 13), a seguir, mostra o ambiente do ArcView após os passos 17, 18 e 19.

PASSO 20: Editou-se a linha de limite fronteiriço já renomeada para LBRF. Com as imagens de satélites e
o tema da feição geográfica LBRF ativados na janela gráfica, selecionou-se o tema para edição, ou seja:
na janela “View” clicar no tema LBRF e depois “Theme => start editing”. A edição significa conectar ao
marco de fronteira os pontos definidores dos segmentos da LLF mais próximos dele, objetivando intercalar
trechos da LLF entre os marcos de fronteira ou quebrar o segmento incluindo um ou mais marcos de
fronteira, traçando assim um novo alinhamento da linha com os marcos de fronteira, por exemplo, nos
casos onde os limites são linhas secas. Estes casos são apresentados na ilustração a seguir (Figura 14).

Obs.: Na edição, a caixa de comando do tema LBRF (retângulo envolvente à esquerda da janela “View”)
fica ressaltada com relação as outras e seu perímetro fica circundado por uma linha tracejada.
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Figura 13: Tela do ArcView com as principais feições geográficas envolvidas.
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PASSO 21:  Configurou-se  o  ambiente  do ArcMap
com o utilitário de configuração avançada do ArcGis
(“Advanced ArcMap Setting”), localizado no diretório
“utilites”  do  ArcGis,  visando  a  projeção  da  Linha
Interna da Faixa de Fronteira.  Após a execução do
aplicativo,  na  aba  “Miscellaneous”  e  na  seção
destinada ao “Buffer  Wizard”  selecionar  o método
“Feature Optimized Coordenate System” e a seguir
aplicou-se a escolha deste 3º método de operações
com a ferramenta, a fim de executar o algoritmo que
cria  um  sistema  de  coordenadas  temporário  para
processamento de buffer (BPCS), baseado em uma
projeção  cartográfica  plana  eqüidistante  azimutal,
conforme tela do utilitário mostrada na Figura 15.

PASSO 22: Criou-se um tema no ambiente do software ArcMap com a feição geográfica LBRF de onde
gerou-se outro tema com “buffer” de 150 km de distância deste objeto espacial, considerando a opção que
resulta na união dos buffers elementares gerados. O resultado pode ser visto na Figura 16.
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Figura 14: Exemplo de dois casos na edição da LBRF

Figura 15: Tela do utilitário de configuração do software ArcMap
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PASSO 23: Inseriu-se o tema “buffer of LBRF” criado no ArcMap no ambiente de trabalho do ArcView,
visando executar operações de interseção com a malha estadual do país. 

PASSO 24:  Processou-se  a  ferramenta  “Geoprocessing
Wizard”  para cortar  do tema buffer  a  área da Faixa  de
Fronteira do Brasil no Estado do Mato Grosso do Sul, a
partir  do  tema  correspondente  à  malha  municipal  do
estado, conforme mostrado na ilustração a seguir (Figura
17).

Obs.:  Como  o  interesse  é  num  objeto  espacial  que
possibilite selecionar municípios ou outras áreas dentro da
faixa  de  fronteira,  não  há  necessidade  de
desmembramento  da  LIFF;  processa-se  a  identificação
dos  municípios  da  faixa  de  fronteira  a  partir  da  LFF
estadual sobre a malha municipal.

PASSO 25:  Com os  temas malha municipal  e faixa  de
fronteira estadual no ambiente de trabalho do Arcview, processou-se a ferramenta “Geoprocessing Wizard”
do ArcView para se obter por interseção com a faixa de fronteira estadual (LFF) os municípios com área
localizada dentro da Faixa de Fronteira do Brasil no Estado do Mato Grosso do Sul (Figura 18).
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Figura 16: Tela do ArcMap após a criação do buffer de 150 km da LBRF

Figura 17: Limites da Faixa de Fronteira do
Brasil no Estado do Mato Grosso do Sul.
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4 Resultados e Discussões

O  resultado  da  aplicação  desta  nova
metodologia no Estado do Mato Grosso
do  Sul,  se  comparado  com  a
identificação de municípios da Faixa de
Fronteira do Brasil do cadastro do IBGE
no  mesmo  estado,  apresentou
divergência  no  total  de  municípios
localizados parcial ou totalmente dentro
desta  faixa  territorial.   Pela  aplicação
desta metodologia, identifica-se pequena
área do município de Nova Alvorada do
Sul dentro da faixa (Figura 19), além dos
44  municípios  constantes  na  relação
oficial,  conforme constantes no mapa a
seguir (Figura 20).

A identificação do município de Nova Alvorada do Sul dentro da faixa de fronteira foi confirmada utilizando-
se  programas  de  cálculos  geodésicos  (problema  inverso),  considerando-se  o  cálculo  da  distância
geodésica a partir de coordenadas de pontos selecionados no limite do referido município e na LBRF
(marco de fronteira) mais próximos.
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Figura 18: A Faixa de Fronteira do Brasil no Estado do Mato Grosso do Sul

Figura 19: Identificação do município de Nova Alvorada do Sul (MS)
como parcialmente dentro da Faixa de Fronteira do Brasil
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No corte do tema buffer pelo tema malha municipal do estado, se invertido, ou seja: se o buffer cortasse a
malha municipal teríamos a faixa de fronteira do Brasil no Estado do Mato Grosso do Sul, dispensando o
próximo passo; porém, não teríamos a feição geográfica correspondente aos limites da faixa de fronteira
(LFF) que possibilita o seu uso a qualquer momento sobre outras bases de dados mais atualizadas. 

A princípio, foi pensado em utilizar-se somente de folhas topográficas para auxiliar a análise cartográfica
realizada na região, com a finalidade de identificar trechos dos limites dos municípios fronteiriços junto à
linha de fronteira internacional,  visando uma definição consistente da linha de base reta construída na
fronteira  (LBRF).  Assim,  previa-se  a  impressão,  via  “plotter”,  de  cartogramas  contendo  as  feições
geográficas  envolvidas,  na  mesma escala  das  folhas  topográficas  utilizadas na  elaboração  da Malha
Municipal  Digital  do  Brasil.  Esta  idéia  veio  a  ser  substituída  pelos  recortes  de  imagens  orbitais
disponibilizados comercialmente pela EMBRAPA Monitoramento de Satélites  durante o desenrolar  dos
trabalhos. 

A análise feita nos trechos dos limites de municípios fronteiriços, com o objetivo de identificação e seleção
de trechos desses limites para intercalar entre os marcos de fronteira, a partir dos recortes de imagens de
sensores orbitais utilizados, mostrou-se suficientemente adequada para tal fim, apesar do deslocamento
observado após o georreferenciamento dos mesmos segundo a articulação das folhas topográficas. Esta
análise, também, contribuiu na definição de critérios de utilização dos marcos de fronteira.

Um melhoramento  poderia ser realizado no “controle terrestre”  dos recortes das imagens de satélites
utilizados, tomando-se como referência o contorno dos limites territoriais da MMD e os marcos de fronteira
e  considerando-se  o  afastamento  médio  em  pixel  nas  direções  norte-sul  e  leste-oeste  dos  acidentes
naturais  (os  que  servem  de  limites  territoriais)  visíveis  nas  imagens.  Este  melhoramento  poderá  ser
efetivado  pelo  desenvolvimento  de  um  programa  de  computador  com  uma  interface  com  o  usuário
permitindo o mesmo proceder tais ajustes.

Outro programa poderia ser  desenvolvido com o objetivo de otimizar  o processo de identificação dos
recortes de imagens de satélites, segundo a articulação das folhas topográficas. O algoritmo seria baseado
na denominação dos arquivos que contêm os recortes de imagens, na área que eles recobrem (escala) e a
articulação da folha topográfica que cada um corresponde. Tal procedimento se justificaria, tendo em vista
a possibilidade da nova metodologia ser aplicada em mais dez unidades da federação.
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Figura 20: A Faixa de Fronteira do Brasil no Estado do Mato Grosso do Sul
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Convém considerar a visualização de coordenadas no ArcView com mais casas decimais de grau decimal,
procedendo a configuração do mesmo com o script a ser implementado no projeto (ESRI, 2001c).

5 Conclusões

O desenvolvimento deste estudo de caso no Estado do Mato Grosso do Sul deu consistência ao estudo
técnico-científico que produziu a metodologia para caracterização espacial da Faixa de Fronteira do Brasil,
além de comprovar a viabilidade de sua aplicação no restante dos estados brasileiros fronteiriços, valendo-
se apenas estudar e desenvolver algumas otimizações no sentido de minimizar tempo de construção da
Linha de Base Reta da Fronteira (LBRF) no ambiente digital e na automatização do georreferenciamento
dos recortes de imagens de satélites, inclusive, com ajustes para melhorar o seu enquadramento diante do
posicionamento dos marcos de fronteira e dos limites municipais da MMD do IBGE.
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